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MultiPlan’s Approach

Facilitating compliance while recognizing our role as a network for lease

» MultiPlan’s MRFs will follow CMS schema v1.0.0 which was posted on March 1, 2022, and reflects the guidance given by CMS at that
time.

= MultiPlan also has adopted two changes CMS communicated at its 3/16/22 webinar which have the affect of significantly reducing
file size: we will separate provider demographic information and related rate information into separate files, and we will reflect the
new negotiation type value “percentage” as it relates to professionals, but not institutions.

= We will evaluate other 3/16 guidance such as the new negotiation type value “per diem” and the “percentage” value as it relates to
institutions — as well as other CMS changes that are likely to be announced - for incorporation after the July 1, 2022 enforcement
date.

= MultiPlan networks are leased by health plans and administrators in a variety of configurations. We make the rate information
available by network without customization. We anticipate each payor will incorporate our data into their plan-specific files.

= Similarly, we make the out-of-network allowed information available by cost management service without customization or
combination.

» Because we are not a health plan, some of the fields in the CMS schema (e.g., HIOS) are not applicable to MultiPlan and are left
unpopulated in the files. We also have left unpopulated most Fields that are not required. Our definition will indicate “empty string”
in these instances.
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About the Schema

For 2022, the respective data elements for the Negotiated Rates for In-Network Providers fall into Five general categories:
= General Information
» |dentification of Plan or Coverage
= |dentification of Providers
» Negotiated Rates
» |dentification of Items & Services

CMS breaks down the required MRF schema (v1.0.0) as Follows:
* |n-Network File
* |n-Network Object
» Bundle Code Object
= Covered Services Object
» Negotiated Rate Details Object
* Providers Object
» Tax Identifier Object
* Provider Reference Object
= Negotiated Price Object

Each schema section is shown on the following pages

) ) ) . B o . . ~ .
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In-Network Files

-
PHCS Network MRF_PHCS MPI_PHCS_innetworkrates_<YYYYMMDD>.json
Beech Street Primary Network MRF_BeechStreet MPI_Beech_innetworkrates_<YYYYMMDD>.json
HealthEOS Network (incl. Plus) MRF_HEOS MPI_HEOS _innetworkrates_<YYYYMMDD>.json
HMA Networks (AMN, RAN, HMN) MRF_HMA MPI_HMA _innetworkrates_<YYYYMMDD>.json

MultiPlan Network (when primary)  MRF_MultiPlanPrimary MPI_MPI_innetworkrates_<YYYYMMDD>.json

PHCS Practitioner + Ancillary MRF_PHCSPracAncil MPI_PHCPA _innetworkrates_<YYYYMMDD>.json
MultiPlan Practitioner + Ancillary MRF_MultiPlanPracAncil  MPI_MPIPA_innetworkrates_<YYYYMMDD>.json

In-Network Test Files MRF_InNetwork_Test MPI_TEST _innetworkrates_<YYYYMMDD>.json

* Please note: the MRF names are slightly different than the CMS naming standard due to internal MultiPlan file transfer requirements. For single plan files, the
CMS naming convention is <YYYY-MM-DD>_<payer or issuer name>_<plan name>_<file type name>.<file extension>. Addtional information and examples can
be found here https://github.com/CMSgov/price-transparency-guide by scrolling down the page.
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In-Network File v1.0.0

Field Name Type Definition Required MultiPlan Definition
reporting_entity name Entity Name String The legal name of the entity publishing the machine-readable file. Yes MultiPlan Inc.
The type of entity that is publishing the machine-readable file (a group
health plan, health insurance issuer, or a third party with which the plan
. . . . or issuer has contracted to provide the required information, such as a .
reporting_entity_type Entity Type String third-party administrator, a health care claims clearinghouse, or a ves Third Party
health insurance issuer that has contracted with a group health plan
sponsor).
plan_name Plan Name String The plan name and name of plan sponsor and/or insurance company. No Network name
plan_id_type Plan Id Type String Allowed values: "EIN" and "HIOS" No Empty string
The 14-digit Health Insurance Oversight System (HIOS) identifier, or, if
lan id Plan ID Strin the 14-digit HIOS identifier is not available, the 5-digit HIOS identifier, No Emoty strin
plan_ 9 or if no HIOS identifier is available, the Employer Identification Number Pty 9
(EIN) for each plan or coverage offered by a plan or issuer.
plan_market_type Market Type String Allowed values: "group" and "individual" No Group
in_network In-Network Negotiated Rates | Array An array of in-network object types Yes Array, see below
provider_references Provider References Array An array of provider reference object types. No Array, see below
: The date in which the file was last updated. Date must be in an 1ISO
last_updated_on Last Updated On String 8601 format (e.g. YYYY-MM-DD) Yes Last monthly update date
version Version String The version of the schema for the produced information No Schema version
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In-Network Object

In-Network Object

Field Name Type Definition Required MultiPlan Definition
An indication as to whether a reimbursement arrangement other than a

negotiation_arrangement | Negotiation Arrangement String standard fee-for-service model applies. Allowed values: "ffs", "bundle" | Yes Approved values
or "capitation".

name Name String This is name of the item/service that is offered Yes Approved values

. - . Common billing code types. Please see a list of the currently allowed

billing_code_type Billing Code Type String codes at the bottom of this document. Yes Approved values
There might be versions associated with the billing_code_type.

billing_code_type_version | Billing Code Type Version String For example, Medicare's current (as of 5/24/21) MS-DRG version is Yes Appropriate version
37.2
The code used by a plan or issuer or its in-network providers to identify

billing_code Billing Code String hea_lth care items or services for purposes of billing, adjudlcat!ng, and Yes Appropriate codes
paying claims for a covered item or service. If a custom code is used
for billing_code_type, please refer to custom billing code values

description Description String Brief description of the item/service No* Empty string

negotiated_rates Negotiated Rates Array This is an array of negotiated rate details object types Yes Array, see below
This is an array of bundle code objects. This array contains all the

bundled_codes Bundled Codes Array different codes in a bundle if bundle is selected for No Empty string
negotiation_arrangement
This is an array of covered services objects. This array contains all the

covered_services Covered Service Array different codes in a capitation arrangement if capitation is selected for No Empty string

negotiation_arrangement

* Please note this field was not required in v1.0.0 README schema on March 1, 2022.
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Bundled Code Object & Covered Services Objects

Bundle Code Object (related array not CMS required)
Field Name Type Definition Required MultiPlan Definition
Common billing code types. Please see a list of the currently allowed

billing_code_type Billing Code Type String codes at the bottom of this document Yes Empty string
- . . . . There might be versions associated with the billing_code_type. For .
billing_code_type version | Billing Code Type Version String example gMedicare‘s current (as of 5/24/21) MS-I:)%G ver?si}(l)?] s 372 Yes Empty string
The code used by a plan or issuer or its in-network providers to identify
- . . health care items or services for purposes of billing, adjudicating, and .
billing_code Biling Code String paying claims for a covered item or service. If a custom code is used ves Empty string
for billing_code_type, please refer to custom bhilling code values
description Description String Brief description of the item/service Yes Empty string

Covered Services Object (related array not CMS required)
Field Name Type Definition Required MultiPlan Definition

Common billing code types. Please see a list of the currently allowed

billing_code_type Billing Code Type String codes at the bottom of this document Yes Empty string
- . - : . There might be versions associated with the billing_code_type. For .
billing_code_type_version | Billing Code Type Version String example gMedicare‘s current (as of 5/24/21) MS-DgliG ver_si)(/)% is 372 Yes Empty string
The code used by a plan or issuer or its in-network providers to identify
- - . health care items or services for purposes of billing, adjudicating, and .
billing_code Billing Code String paying claims for a covered item or service. If a custom code is used ves Empty string
for billing_code_type, please refer to custom bhilling code values
description Description String Brief description of the item/service Yes Empty string

) ) ) . B o . . ~ .
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Negotiated Rate Details, Providers & Tax Identifier Objects

Negotiated Rate Details Object

Service (IRS) for type "ein" or the provider's npi for type "npi".

Field Name Type Definition Required MultiPlan Definition
. . . . An array of negotiated price objects defines information about the type
negotiated_prices Negotiated Prices Array of negotiated rate as well as the dollar amount of the negotiated rate ves Array, see below
. . The providers object defines information about the provider and their .
provider_groups Provider Groups Array associated TIN related to the negotiated price. No Provider Info
provider_references Provider References Array gr;jzgf y of provider_group_ids defined in the provider reference No Array, see below
Providers Object
Field Name Type Definition Required MultiPlan Definition
npi NPI Array An array of individual (type 1) provider identification numbers (NPI). Yes Array
in Tax Identification Number Object The_ tax identifier object contains tax information on the place of Yes 9-diigit TIN
business
Tax ldentifier Object
Field Name Type Definition Required MultiPlan Definition
type type String Allowed values: "ein" and "npi". Yes EIN
value value String Either the unique identification number issued by the Internal Revenue Yes TIN or NPI
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Provider Reference Object

I
Field Name Type Definition Required MultiPlan Definition
provider_group_id Provider Group Id Number The unique, primary key for the associated provider_group object Yes Group ID
. . The providers object defines information about the provider and their
provider_groups Provider Groups Array associated TIN related to the negotiated price. No Array, see above
A fully qualified domain name on where the provider group data can be
location Location Strin downloaded. The file must validate against the requirements found in No Fully qualified domain name
9 the provider reference. Examples can be found here that would link to ya
a valid provider reference file such as one found here.

Additional Notes Concerning provider_group, location: Either a provider_group or location attribute will be required in the Provider Reference Object.
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Negotiated Price Object

Field Name Type Definition Required MultiPlan Definition
There are a few ways in which negotiated rates can happen. Allowed

negotiated_type Negotiated Type String values: "negotiated”, "derived", and "fee schedule", "percentage"”, and Yes Approved values
"per diem". See additional notes. D

negotiated_rate Negotiated Rate Number The dollar or percentage amount based on the negotiation_type Yes Negotiated rate
The date in which the agreement for the negotiated_price based on the

expiration_date Expiration Date String negotiated_type ends. Date must be in an ISO 8601 format (e.g. YYYY-| Yes Evergreen
MM-DD). See additional notes.
The CMS-maintained two-digit code that is placed on a professional

An array of : o S . . !
. . L claim to indicate the setting in which a service was provided. When
service_code Place of Service Code two-digit . . . ) . . . | No Approved values
Strings attribute of billing_class has the value of "professional”, service_code is
9 required.

billing_class Billing Class String Allowed values: "professional”, "institutional” Yes Approved values
An array of strings. There are certain billing code types that allow for
modifiers (e.g. The CPT coding type allows for modifiers). If a

billing_code_modifier Billing Code Modifier Array negotiated rate for a billing code type is dependent on a modifier for the| No Approved values
reported item or service, then an additional negotiated price object
should be included to represent the difference.
The additional information text field can be used to provide context for

additional_information Additional Information String negotiated arrangements that do not fit the existing schema format. No Additional information where

Please open a Github discussion to ask a question about your situation
if you plan to use this attribute.

available
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About the Schema

For 2022, the respective data elements for the Historical Allowed Amounts and Billed Charges For Out-of-Network
Providers Fall into five general categories:

» General Information

» |dentification of Plan or Coverage

= |dentification of Providers

= Historical OON Allowed Amounts

» |dentification of Items & Services

CMS breaks down the required MRF schema as Follows:
= Qut-of-Network Allowed Amount File
» Qut-of-Network Object
= Allowed Amounts Object
» Tax Identifier Object
» Qut-of-Network Payment Object
= Additional Notes
* Provider Object

Each section is shown on the Following pages
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Out-of-Network Files

GlobalScape .
sewice | LeRERS e | MRFNeme (i)

Data iSight MRF_Data_iSight MPI_DiS_allowedamounts_<YYYYMMDD>.json

Viant (IPR/OPR) MRF_IPROPR MPI_IPROPR_allowedamounts_<YYYYMMDD>.json
Negotiation Services (incl. Globals & SRA) MRF_Negotiations MPI_Negotiations_allowedamounts_<YYYYMMDD>.json
HST Medicare-based pricing MRF_HST MPI_HST _allowedamounts_<YYYYMMDD>.json

MultiPlan Network, Beech Street, IHP MRF_MultiPlanBeechlHP  MPI_MPIBeechIHP_allowedamounts_<YYYYMMDD>.json
Out-of-Network Test Files MRF_OutOfNetwork_Test MPI_TEST allowedamounts_<YYYYMMDD>.json

* Please note: the MRF names are slightly different than the CMS naming standard due to internal MultiPlan file transfer requirements. For single plan files, the
CMS naming convention is <YYYY-MM-DD>_<payer or issuer name>_<plan name>_<file type name>.<file extension>. Additional information and examples can
be found here https://github.com/CMSgov/price-transparency-quide by scrolling down the page.
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Out-of-Network Allowed Amount File v1.0.0

Field Name Type Definition Required MultiPlan Definition
reporting_entity_name Entity Name String The legal name of the entity publishing the machine-readable file. Yes MultiPlan Inc.
The type of entity that is publishing the machine-readable file (a group
health plan, health insurance issuer, or a third party with which the plan
. . . . or issuer has contracted to provide the required information, such as a .
reporting_entity_type Entity Type String third-party administrator, a health care claims clearinghouse, or a Yes Third Party
health insurance issuer that has contracted with a group health plan
sponsor).
plan_name Plan Name String The plan name and name of plan sponsor and/or insurance company. No Network name
plan_id_type Plan Id Type String Allowed values: "EIN" and "HIOS" No Empty string
The 14-digit Health Insurance Oversight System (HIOS) identifier, or, if
lan id Plan ID Strin the 14-digit HIOS identifier is not available, the 5-digit HIOS identifier, No Emoty strin
plan_| 9 or if no HIOS identifier is available, the Employer Identification Number Pty 9
(EIN)for each plan or coverage offered by a plan or issuer.
plan_market_type Market Type String Allowed values: "group" and "individual" No Group
out_of _network Out Of Network Array An array of out-of-network object types Yes Array, see below
. The date in which the file was last updated. Date must be in an ISO
last_updated_on Last Updated On String 8601 format (e.g. YYYY-MM-DD) Yes Last monthly update date
version Version String The version of the schema for the produced information No Schema version
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Out-of-Network Object

Out-of-Network Object

Field Name Type Definition Required MultiPlan Definition
. The name of each item or service for which the costs are payable, in
name Name String ) Yes Approved values
whole or in part, under the terms of the plan or coverage.
- - . Common billing code types. Please see a list of the currently allowed
billing_code_type Billing Code Type String codes at the bottom of this document. Yes Approved values
billing_code Billing Code String The billing_code_type code for the item/service Yes Appropriate codes
- . - . . There might be versions associated with the billing_code_type. For . .
billing_code_type_version| Billing Code Type Version String example, Medicare's current (as of 5/24/21) MS-DRG version is 37.2 Yes Appropriate version
Brief description of the item or service. In the case of items and
services that are associated with common billing codes (such as the
descrintion Description Strin HCPCS codes), the codes’ associated short text description may be Yes Emoty strin
P P 9 provided. In the case of NDCs for prescription drugs, the plain Pty 9
language description must be the proprietary and nonproprietary
names assigned to the NDC by the FDA
allowed_amounts Rates Array An array of allowed amounts objects. Yes Array, see below
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Allowed Amounts & Tax Identifier Objects

Allowed Amounts Object

Field

Service (IRS) for type "ein" or the provider's npi for type "npi".

Name Type Definition Required MultiPlan Definition
tin Tax Identification Number Object ;S;;Z);;dentmer object contains tax information on the place of Yes 9-digit TIN/repriced TIN
The CMS-maintained two-digit code that is placed on a professional
An array of ) o o : . !
. Place of L claim to indicate the setting in which a service was provided. When
service_code : two-digit . . R . . . . | No Approved values
Service Code : attribute of billing_class has the value of "professional”, service_code is
strings .
required.
billing_class Billing Class String Allowed values: "professional”, "institutional” Yes Approved values
payments Payments Array An array of out-of-network payments objects Yes Array, see below
Tax ldentifier Object
Field Name Type Definition Required MultiPlan Definition
type type String Allowed values: "ein" and "npi". Yes EIN
value value String Either the unique identification number issued by the Internal Revenue Yes TIN®

* Please note with an out-of-network claim MultiPlan is not able to identify if a SSN is being used as a TIN
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Out-of-Network Payments & Provider Objects

Out-of-Network Payments Object

Field Name Type Definition Required MultiPlan Definition
The allowed amount must be reported as the actual dollar amount the

allowed_amount Allowed Amount Number plan or ISsuer paid tq the out-of-netw(_)rl_< proylder for_a_ par'tlcular Yes Median $ amount
covered item or service, plus the participant's, beneficiary's, or
enrollee's share of the cost. See additional notes.
An array of strings. There are certain billing code types that allow for
modifiers (e.g. The CPT coding type allows for modifiers). If a

billing_code_modifier Billing Code Modifier Array negotiated rate for a billing code type is dependent on a modifier for the| No Approved values
reported item or service, then an additional negotiated price object
should be included to represent the difference.

providers Providers Array An array of provider objects Yes Array, see below

Provider Object

Field Name Type Definition Required MultiPlan Definition

billed_charge Billed Charge Number The total dollar amount charges for an item or service billed to a plan or Yes Median $ amount
issuer by an out-of-network provider.

npi National Provider Identifier Array An array of provider identification numbers (NPI) Yes Array
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